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1. Introduction 
 
Welcome to VnetPC Pro. This latest upgrade of the popular ventilation simulation program 
combines the input of ventilation and mining engineers from around the world to provide an 
unparalleled engineering tool.  This program continues to be designed by practicing ventilation 
engineers.  Credit for many of the new features goes to the hundreds of users in the mining and 
tunneling industries throughout the world. 
 
The applicability of VnetPC to subsurface ventilation system design ranges from the initial 
concept through to the system operations phase of a project. Given information that describes the 
geometry of a ventilation network, airway resistances or dimensions, and the locations and 
characteristic curves of fans, the code will produce listings and visual graphics of many 
parameters. The output includes predicted airflows, frictional pressure drops, air power losses in 
airways, contaminant flows and concentrations, and fan operating points. 
 
VnetPC has been developed specifically for computers operating under the Windows 
environment. The system is supplied on one CD-ROM. Data files and fan databases prepared 
using the previous version of VnetPC 2007 and VnetPC 2003 can be imported and converted for 
use with the latest program. 
 
Prior to installing the software, it is recommended that the user become familiar with this User’s 
Manual. This manual provides an overview of the VnetPC package and software encryption 
routine that is recommended for both new users, and for users of previous versions. 
Comprehensive Help Menus are included with the program to further assist users in 
understanding how the program works. To access the Help Menu, click on the Help Menu above 
the tool bar. A tutorial section is included with this manual, which provides a quick-start to 
developing ventilation networks. 
 
If you have any questions or comments regarding VnetPC please do not hesitate to contact us. 
Mine Ventilation Services, Inc. (MVS) maintains a comprehensive web site, which includes up-
to-date information on VnetPC. We also offer free technical support to all users of the latest 
version of the VnetPC Program. Thank you for choosing the VnetPC software program, and for 
supporting the continued development of the code. 
 

Mine Ventilation Services, Inc. 
1625 Shaw Ave., Suite 103 
Clovis, California  93611 
United States of America 
 
Telephone: 1-559-452-0182 
Facsimile: 1-559-452-0184 
Email:  support@mvsengineering.com 
Website:  www.mvsengineering.com 
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2. Overview of VnetPC 
 
The VnetPC program is designed to assist the mine ventilation practitioner in the planning and 
monitoring of underground ventilation layouts. Given data that describes the geometry of the 
mine network, airway resistances or dimensions, and the location and characteristic curves of 
fans, the program will provide graphical and tabular representations of various predicted 
ventilation parameters. 
 

2.1 VnetPC: Its Applications and Uses 
 
VnetPC can simulate existing ventilation networks such that fan operating points, airflow 
quantities, and frictional pressure drops approximate those of the actual system. This is 
accomplished using data from ventilation surveys together with information determined from 
known airway dimensions and characteristics. Proposed subsurface facilities may also be 
designed using VnetPC. Such simulations are conducted by incorporating physical input data 
from conceptual plans with documented design parameters used to determine estimated 
resistances for airways in the network. The range of fan duties required, airflows, pressure drops, 
operating costs, and the location of ventilation controls may be ascertained for the entire life of a 
project by conducting time-phase exercises. Options within VnetPC allow for the display and 
manipulation of three-dimensional networks, production of listings and output files, and plots of 
input and output data. 
 

2.2 Background Theory of VnetPC 
 
The VnetPC Program has been developed with the assumption of incompressible flow and is 
based on Kirchhoff's Laws. The code utilizes an accelerated form of the Hardy Cross iterative 
technique to converge to a solution. 
 

2.3 List of Main Program Features 
 
• Full-color, interactive 3D network schematic 
• Enhanced, expandable coordinate system 
• Data input and output via the Schematic or tabular views 
• Color coding of branches for airway type (user defined) 
• Import DXF files from CAD and mine planning programs 
• Ability to enter series and parallel arrangements for fans 
• Imperial and SI units with full data conversion 
• Automatic allocation of surface branches to close meshes around surface nodes 
• Notepad to enter detailed description of simulation 
• Full annotation capabilities in all schematic views - allows angled text 
• Automatic calculation of branch length from coordinate values 
• Regulator orifice sizing tool 
• Default network size limit is 10,000 branches, 4,000 junctions, and 600 fans 
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• Extensive Help Tools and Tutorials 
• Full online support at www.mvsengineering.com 
• Direct graphic printing and multi-colored plotting 
• Export DXF files to CAD and mine planning programs – attribute exported specifically 

chosen 
• Four input data types for branch resistance 
• Steady state contaminant distribution analyses 
• Fixed quantity tool 
• Color coding of branches for range of parameter (airflow, pressure, etc.) 
• Dual parameters display in schematic view 
• Cut/copy/paste features for data exchange within Windows 
• Variable frequency drives – fan curve adjustments for density and frequency (RPM) 
• Edit branches in multiple views 
• Fan curve graphics with current operating point displayed 
• Transient time calculator based on user-selected path 
• Branch templates 
• Multiple branch selection and editing 
• Editing single or multiple branch properties with templates 
• Scroll wheel zooming 
• Pan with center mouse wheel 
• Fan stall warnings 
• Shock loss calculator with reference material 
• Isometric (3D) editing capabilities  
 

2.4 Minimum System Requirements of VnetPC 
 
• IBM Compatible Computer running Windows XP, Vista or Windows 7 
• Intel Pentium class processor or above 
• 512 MB RAM Memory 
• 100 MB Hard Disk Space for the VnetPC Program (additional for Adobe Acrobat ReaderTM) 
• CD/DVD Drive 
• USB Slot (HASP Key) 
• VGA Display 
 

2.5 Setup Procedure 
 
The VnetPC Program is shipped as a single installation file on a CD-ROM (VnetPC Pro 
Setup.EXE).  The following installation instructions will assist you in achieving a trouble-free 
installation, regardless of what operation system you are running, or whether or not you already 
have a version of VnetPC installed on your machine.  Please note that there is an additional setup 
file for installing the network version on a server.  
 

1. Insert VnetPC Pro distribution disk into the CD/DVD Drive and execute the self-
installing utility program from VnetPC Pro Setup.exe. 
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The default install directory is C:\Program Files\VnetPC Pro\ or other as specified by the 
user.  The installation process creates the directory and inserts the associated program and 
ancillary files.  When the installation is complete, a shortcut for VnetPC Pro will appear 
on the desktop.   
 

2. Plug the HASP key tag into a USB port.  Windows should automatically install the latest 
device drivers for the HASP key if your computer has an active internet connection.  If 
Windows does not install the HASP device drivers automatically, the device drivers can 
be found on the installation disc, or at our website: www.mvsengineering.com 
 
Once the installation of the HASP device drivers is complete, a red light will activate in 
the HASP key tag.  The red light will remain on as long as the HASP key tag is plugged 
into the machine and is functionally properly.   

 
3. Click on the shortcut to start VnetPC Pro program. 

 
a. The program should open. 
b. Use the File New VnetPC Pro File sequence to open a new model illustrated 

in Figure 1.  
 

 
Figure 1: New Model 

 
c. Next a dialog box should appear, as shown below in Figure 2, requesting you to 

select the system of units for this model.  Select units desired for your model and 
press “OK”.   
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Figure 2: Unit Selection Dialog Box 

 
d. If you get an Untitled – Model Information dialog box, the program and the 

associated support programs are installed correctly. 
 
Congratulations!!  You can now begin using VnetPC Pro ventilation simulation program. 
 
If the VnetPC Pro program window does not open, but you get a HASP not found (x) error 
please verify: 
 
HASP not found (0) – that the HASP device is properly attached to the computer (on a USB 
HASP the red light in the device should be on).  
 
Now, that the program is functioning, check the version number: 
 Help About Vnetwin 
 
Then check for updates and patches: www.mvsengineering.com/download.htm 
 
If the patch has a higher version alpha-numeric than shows up in the help about information 
panel, then you may download the patch. 
 
Simply “Save Target” to your program directory and then extract the replacement *.exe and *.dll 
files to over-write the existing version in the installation directory.  Note that if you retain the 
current program files as a backup, you will need to make sure that you manually verify any 
shortcut associations.  Windows may retain the shortcuts targeted to the original program files 
rather than the installation directory. 
 
If you have any further questions with regard to the installation process, or the operation of this 
or other MVS software, please feel free to contact us by telephone: 1-559-452-0182 or email: 
support@mvsengineering.com.  
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2.6 Software Encryption 
  
The VnetPC Program is protected by a software hardlock (HASP).  The hardlock device is 
installed on a USB port of the computer or server (Net-HASP).  After the VnetPC Program is 
installed, the hardlock device drivers must be installed.  If your PC has an active internet 
connection, Windows may download and install the necessary drivers automatically.  For the 
single user version of VnetPC Pro, the driver installation routine will be located on the 
installation disc, for the multi-user version of the program the driver installation routine will be 
located in a separate “Net-HASP License Manager” directory. 
 
If any problems are encountered please contact MVS.  MVS can be reached at; phone (559) 452-
0182, fax (559) 452-0184, or e-mail at MVS at support@mvsengineering.com. 
 

3. Data Preparation and Input 
 
VnetPC is structured such that the user moves between views, or windows, where input and 
output data are located. A single file is used for the network input, schematic coordinates, and 
contaminant data. A separate archive file is used to store multiple fan curves. Creating, 
importing, editing, or viewing fan curves are performed within the VnetPC Program. The 
VnetPC Program comprises ten screens for the input and display of program data. The screens 
are listed on the Menu Bar under the “Go To” Menu. These views are: 
 
• Model Information 
• Branch Input  
• Branch Results 
• Branch Templates 
• Fixed Quantities 
• Fan Input 
• Fan Results 
• Junction Data 
• Schematic 
• Contaminants 
 
This section details the content and form of the input data required for the VnetPC Program. The 
data requirements are presented in six categories: 
 
1. Ventilation Network  (page 7) 
2. Descriptive Data    (page 8) 
3. Branch Data   (page 10) 
4. Fan Data     (page 29) 
5. Fixed Quantity Tool   (page 35) 
6. Contaminant Distribution Data  (page 36) 
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3.1 Ventilation Network (Schematic) 
 
A ventilation network is a graphical representation of a ventilation system and consists of a set of 
junctions and interconnecting lines (branches) which denote major or significant airflow routes. 
The following subsections describe the schematic requirements. 
 
3.1.1 Closed Circuit 
 
The network schematic must consist of interconnected branches that form closed circuits. Each 
branch should represent a single airway, a group of airways, or leakage paths. VnetPC will 
automatically close those branches connected to the surface, as long as the user specifies them as 
being either "Surface Intake" or "Surface Exhaust" branches. There are options to select the 
surface state of the various network branches in both the Schematic and Branch Input Views 
(refer to Section 3.3.3.5). 
 
3.1.2 Junction Numbers 
 
Junction numbers must be assigned to each junction in the schematic.  Valid numbers are whole 
integers from 1 to 10000.  VnetPC is capable of selective viewing and printing of branches 
interconnected to any specified range of junction numbers.  VnetPC will automatically allocate 
junction numbers for new branches drawn in the Schematic View or for imported data from a 
DXF file. 
 
3.1.3 Schematic Layout 
 
Three techniques can be used to enter the schematic into VnetPC: 
 
1. Draw the schematic in a CAD or mine planning program (established as a unique layer, 

perhaps called VnetPC) and import to VnetPC. This method is typically adopted when the 
user wants to drape/overlay the ventilation network on a mine plan (within a CAD program). 

2. Directly plot the network on the screen using the Vnet drawing tools (acceptable for smaller 
networks and where precise geometry is not necessary). 

3. Numerically enter the coordinate data in tabular form, or copy the coordinate data from a 
spreadsheet and paste into the Junction Data View. 

 
Note: Scaling and Offset of Coordinates during DXF import 
 
VnetPC supports real-world coordinates, and will generally import exact coordinates from CAD 
programs.  The exception is when the program has to apply an offset to the imported data, and/or 
scale the network because the coordinate range is too great for the VnetPC views (coordinate 
values greater than 1 billion).  Any scaling or offset is identified to the user during the importing 
process.  For importing multiple layers or DXF files into the same network, the initial offset and 
scaling information (used for the first layer) will automatically be applied to all subsequently 
layers. 
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3.1.4 Parallel Branches 
 
Users experienced with previous versions of VnetPC have indicated that confusion can arise if 
two or more branches are entered with identical From and To junction numbers. VnetPC checks 
for this condition during data entry and will not allow duplicate branches. However the user can 
effectively connect any two junctions with parallel branches by either reversing the junction 
numbers or inserting intermediate nodes. 
 
Note: Parallel Branch Tool 
 
A tool is available to allow the user to rapidly adjust the resistance of a branch according to 
parallel network theory. This tool is accessible in both the Branch Input View (Parallel Factor 
column) and the Schematic View (Branch Data dialog box). The user may enter a number, with 
the default being 1. If the user selects a 2, then the code will adjust the input branch resistance to 
double the number of airways represented by the branch. If the user were to enter 0.5, then the 
resistance would be adjusted to give half the number of airways represented in the branch. If the 
user enters 1, then the resistance is reset to the original value.  During ventilation surveys, 
resistances are determined for parallel entries and are input directly to the model.  Although only 
one branch is modeled it will sometime actually represent two or more parallel entries.  Care 
should be taken to identify exactly how many entries are incorporated into the original resistance 
value. 
 

3.2 Descriptive Data 
 
Descriptive data consists of both required and optional information for documentation and 
program initiation. This information is modified in the Model Information View. The Model 
Information View allows data to be directly entered into fields as shown in Figure 3. 
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Figure 3: Model Information View 

 
The following subsections describe the input and required format for the data in the Model 
Information View. 
 
3.2.1 File Name 
 
A file name must be assigned when saving the file for the first time, or when utilizing the “Save 
As” command under the File Menu. When a file is saved, the program automatically prompts for 
the extension .vdb. VnetPC supports extended file names. 
 
3.2.2 Units and Conversion Utility 
 
VnetPC supports both Imperial and SI units. The user must initially specify one type of 
engineering unit; however, should the user decide to change units, an automatic conversion 
feature is available. This conversion feature is available from the Tools Menu in any view. The 
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conversion utility converts all the input data including the fan curves. It is important that the user 
executes the program following unit conversion. In rare cases during conversion, one or more 
data values may become out of range, and the program will truncate the values. However, this 
will only occur if the original network contains extremely high input parameters, and the 
truncated values should still be sufficiently large so that the network accuracy is not impacted. 
 
3.2.3 Power Cost 
 
The user should enter an electrical power cost to determine the operating cost for the system 
fans. Power costs are provided in units/kWh, where the unit may be any currency. 
 
3.2.4 Air Density and Regulator Sizing and Shock Loss Calculator 
 
The user is required to input an average air density for the underground.  This value is needed to 
compute the orifice area for any regulators listed in the Fixed Quantity View.  The average air 
density parameter is used to calculate shock losses added to branches.   
 
3.2.5 Notepad (Comments) 
 
There is a large text field available to enter a detailed description of the particular file.  
Information may include a title, summary of results, and the specific details associated with that 
model.  This Notepad is seen in the Model Information View.  Text may be entered directly in 
the reduced window or the Notepad may be maximized by pressing the Edit key.  Users need  to 
deactivate a modified field by choosing a new active field before attempting to save the file.  
Changes made to an active field will not be retained when the file is saved. 
 

3.3 Branch Data 
 
3.3.1 Branch Data Formats 
 
Each branch is defined by two junctions and by numerical data that indicate the characteristics of 
the airway.  Data may be entered in any of four formats. The mouse can be used to copy and 
paste ranges of data between branches in the Branch Input View or from other Windows 
applications (such as spreadsheets or other ventilation simulators).  Once data is entered into the 
program, the data will remain until deleted or overwritten by new data of the same format.  If the 
resistance type is changed to a different data format, original data entered for other formats will 
be retained and available though inactive. 
 
VnetPC recognizes four branch data formats: Fixed Resistance (R), Pressure Loss and Airflow 
Quantity (p/Q), Atkinson Friction Factor (k-factor), and Resistance Per Branch Length (R/L). A 
branch data format is chosen for each branch depending on information available about the 
airway to be represented.  The format for each branch is independent of the other branches in the 
model and can be changed at any time.  The available branch types may be accessed in the 
Branch Input View from a drop-down list under the appropriate column for each branch as 
shown in Figure 4.  These types can also be set or modified in the Branch Data Dialog from the 
Schematic View as shown in Figure 5. 
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Figure 4: Branch Input View 

 

 
Figure 5: Branch Information Dialog Box 
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The Branch Data Dialog box can be accessed from the Schematic view using the Edit tool or the 
Selection Pointer.  The Edit tool can be selected in the Tools drop down menu or by selecting the 
Edit tool icon  located on the Drawing toolbar and pressing the left mouse button while 
hovering the cursor over a branch.  The Selection Pointer is available under the Tools drop down 
menu or by selecting the Selection Pointer icon  on the Drawing toolbar.  By pressing the right 
mouse button when hovering the cursor over a branch, the user can select the Branch Data option 
from the list.  Using either of these methods will call up the Branch Data dialog box, illustrated 
in Figure 5.  Branch types and other branch data can be changed in this view. 
 
VnetPC has a feature that links a numerical code to the branch data format options to assist the 
user when entering data into the Branch Input View using the number pad on a keyboard.  A 
code of 1, 2, 3 or 4 can be entered in the branch type field to call up the respective branch type 
rapidly.  The number and type associations are given in Table 1.  
 
Table 1 - Branch Data Types 
Data Type Entry Form Comments 

1 R (airway resistance) Fixed resistance 
2 p, Q (frictional pressure drop and quantity) Pressure drop - volume data 
3 k, L, Leq, A, Per (friction factor, length, 

equivalent length, area and perimeter) 
Required input for Atkinson’s 
Equation 

4 R/Length, L, Leq (resistance per unit 
length, airway length and equivalent 
length)  

Allows direct calculation of 
resistance from previously 
measured resistance 

 
A detailed description of the four data entry formats is described in the following sections. 
 
3.3.1.1 Resistance Data 
 
The Resistance data type (R) requires that a resistance value be input for the branch. This data 
type is useful for branches with a known or previously computed resistance. A common example 
would be adding a stopping or door using an average resistance value calculated from survey 
data.  When a new branch is created in either the Branch Input or Schematic views, the default 
branch data type is R. 
 
3.3.1.2 Pressure and Quantity Data 
 
The p/Q data type requires pressure loss and volume flow (quantity, Q) values to be input. These 
values are typically obtained from a pressure-quantity survey using the gauge and tube method 
for pressure loss and vane anemometers for airflow quantity. Vnet PC Pro calculates the 
resistance, R, on the basis of the Square Law, as given in Equation 1.  Directly entering survey 
data allows the user to bypass a calculation step when preparing data and helps facilitate 
correlation between measured airflow values and those resulting from the model simulation. 
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Equation 1:    2Q
pR =   

 
Where:  R = airway resistance (Practical Unit [P.U.] or Ns2/m8) 
  p = pressure drop (milli inch w.g. or Pa) 
  Q = flow rate (kcfm [× 1000 cfm] or m3/s) 
 
3.3.1.3 Atkinson Friction Factor (k-factor) 
 
The k-factor data type requires the physical characteristics of the airway to be input, including:  
Atkinson Friction Factor (k-factor), length (L), equivalent length of shock loss (Leq, if desired), 
perimeter (Per), and cross-sectional area (A). This data type computes branch resistance using an 
empirical formula known as Atkinson's equation, expressed below in Equation 2: 
 

Equation 2:     3

)(
cA

PLLk
R ereq+
=   

 
Where:  R = airway resistance (Practical Unit or Ns2/m8) 
  k = friction factor (lbf min2/ft4×10-10 or kg/m3) 
  L = length of airway (ft or m) 
  Leq = equivalent length of shock loss (ft or m) 
  A = area (ft2 or m2) 
  Per = perimeter of airway (ft or m) 
  c = constant (Imperial = 52 and SI = 1) 
 
VnetPC verifies each entry as it is input and, if invalid, requests re-entry. It should be noted 
when inputting a value for k-factor in Imperial Units into the Branch Data: the 10-10 factor must 
not be included in the entry. Hence, for a typical airway with a k-factor of 65 ×10-10 lbf min2/ft4, 
the user would enter only 65. Note that VnetPC uses a constant of 52 not 5.2 in the Atkinson 
Equation. This allows the Atkinson friction factor to be entered directly without including 
the 10-10 factor. The resulting unit is termed the Practical Unit (PU).  This same unit is 
obtained from the Square Law by using milli inch w.g. (thousandths of an inch w.g.) and kcfm 
(thousand cubic feet of air per minute). 
 
To facilitate input of friction factors, a user-defined list of k-factors may be accessed by clicking 
the ‘Select K-factor’ button on the Branch Data dialog box.  The Select Friction Factor dialog 
box will appear as shown in Figure 6.  Use the selection pointer and left mouse click on a cell in 
the row of the desired k-factor and press ‘OK’ to apply the k-factor to the branch.  
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Figure 6: Friction Factor Dialog Box 

 
The ‘Select Friction Factor’ feature allows the user to enter a k-factor value and description for 
each variety of airways to be modeled with the k-factor data type.  These stored values can then 
be recalled rapidly to populate resistance data for future branches.  The Select Friction Factor 
dialog box can also be accessed in the Branch Input view from the ‘Branch’ drop-down when a 
k-factor field is selected.  An additional way to access the stored friction factors from the Branch 
Input view is to double click on the edge of the spreadsheet cell for the friction factor of a 
desired branch. 
 
3.3.1.4 Resistance per Length Data Format 
 
The resistance per unit length (R/L) data type allows the user to input an empirical resistance per 
length value for the airway and requires branch length.  Equivalent length of shock losses may 
also be entered if desired. Resistance per unit length values for the airways being modeled are 
typically obtained from survey results or empirically computed using suitable friction factors and 
airway geometry. 
 
It is most common to use this data type for extending existing airways without requiring the 
calculation of k-factors.  This is only effective if characteristics such as the dimensions of the 
opening, roof control methods, and airflow obstructions are consistent along the length of the 
airway.  Resistance per length values are typically calculated as the average of the values of 
several similar airways.  This will eliminate anomalies that commonly occur during ventilation 
surveys and yield more realistic results than values from a single branch or estimated using a 
table of k-factors. 
 
The process for entering R/L values is identical to that for entering k-factors in both the 
Schematic view and the Branch Input view.  To facilitate input of R/L values, a user-defined list 
of R/L values may be accessed by clicking the ‘Select R per L’ button on the Branch Data dialog 
box.  The Select Resistance Per Length dialog box will appear as shown in Figure 7.  Use the 
selection pointer and left mouse click on a cell in the row of the desired R/L value and press 
‘OK’ to apply the R/L value to the branch.  Note: Resistance per length values are input per 
1,000 units (ft or m).  
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Figure 7: Resistance per Length Values Dialog Box 

 
The ‘Select R per L’ feature allows the user to enter an R/L value and description for each 
variety of airways to be modeled with the R/L data type.  These stored values can then be 
recalled rapidly to populate resistance data for future branches.  The Select Resistance Per 
Length dialog box can also be accessed in the Branch Input view from the ‘Branch’ drop-down 
when an R/L field is selected.  An additional way to access the stored R/L values from the 
Branch Input view is to double click on the edge of the spreadsheet cell for the R/L value of a 
desired branch. 
 
3.3.1.5 Automatic Length Tool 
 
The VnetPC Program incorporates an automatic length tool to provide a length value based on 
junction coordinates. This feature can be activated for each branch through the appropriate 
column in the Branch Input view and through the Branch Data dialog in Schematic view.  
Universal settings for this feature can be adjusted by selecting ‘Auto Length’ in the Tools drop 
down menu in most views.  This displays the Automatic Branch Length Calculation dialog box 
as shown in Figure 8. 
 

 
Figure 8: Automatic Branch Length Dialog Box 
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The top section of the dialog box sets the default for any new branches added to the network. If 
the automatic length feature is enabled, the program will calculate the branch length based on the 
x, y and z coordinate data of the two junctions that define the branch. This feature is commonly 
activated when the model is created to scale from a dxf.  It is important to note that VnetPC 
assumes that each division (coordinate) in Imperial units is 1 foot and in SI Units is 1 meter.  The 
units of a source dxf must be identified correctly when imported as this cannot be adjusted 
afterward.  
 
When Autolength is enabled, the length field will become “read only” or “grayed out” in both 
the Branch input and Branch Data dialog views.  This is indicated by changing the color of the 
text and fill of the field.  The user will not be able to edit this inactive field while Autolength is 
enabled. 
 
Modifying junction locations or creating a not-to-scale model can make viewing and 
manipulating the model easier.  The automatic length tool will update the branch length when 
there has been a change in the location of one of the junctions or if the branch junction numbers 
have been reassigned.  When modifying junction locations care should be taken to enter correct 
airway lengths by hand in order to achieve realistic branch resistance values when using the k-
factor and R/L data formats are used.  This is especially important for branches used to represent 
shafts and raises.  Length values are also required for calculating airflow velocity.  Airflow 
velocity values can be displayed in the Schematic view and are required for contaminant flow 
and transient time calculations.   
 
The lower section of the Automatic Branch Length Calculation dialog box allows changes to be 
made to existing branches. The default is set to "Make no changes." If the user selects to enable 
the automatic length feature for all existing branches, the length of all existing branches will be 
updated to the respective computed values.  Any existing length data will be overwritten and is 
not retained.   
 
During unit conversion, the length of branches is converted automatically regardless of 
Autolength status.  The coordinates in the Schematic View are also converted, resulting in 
updated length data from the automatic length feature. 
 
3.3.1.6 Shock Loss Calculator 
 
The VnetPC Program incorporates a tool to calculate and apply shock loss resistances to 
branches.  This feature can be activated for each branch through the Branch Data dialog box in 
Schematic View or the appropriate column in Branch Input.   
 
A shock loss resistance may be added to any branch in the ventilation model.  This feature can be 
enabled or disabled at anytime in the ventilation model and when disabled will retain the shock 
resistance value but will not apply it to the system.   
 
To add a shock loss resistance to the model with the Branch Data dialog box the user must 
“Enable” the Shock Resistance using the drop-down menu located on the right of the dialog box.  
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Users then may manually add a value to the Shock Resistance text box or select “Calc Shock 
Loss” to calculate a shock loss resistance.   
 
In order for VnetPC Pro to calculate the shock loss resistance, users must define three 
parameters; airway cross-sectional area, average mine air density, and shock loss factor.  The 
cross-sectional area is user defined for each branch in the Branch Data dialog box or Branch 
Input screen.  The average mine air density is user defined on Model Information view.  After 
the user selects “Calc Shock Loss” the Shock Loss Factor dialog box will be displayed (see 
Figure 9).  Shock loss (X) factors may be defined as the number of velocity head that give the 
frictional pressure loss due to turbulence at any bend, variation in cross-sectional area, or any 
other configuration that causes a change in the general direction of airflow.  Users may select 
Reference for additional information for selecting a Shock Loss Factor.  After users enter a shock 
loss factor and press “OK”, the calculated shock loss resistance will appear in the Branch Data 
dialog box.  
 

 
Figure 9: Shock Loss Factor Dialog Box 

 
3.3.2 Branch Input View 
 
Branch characteristic data can be entered and modified in a manner typical of Windows-based 
spreadsheets in the Branch Input view. A branch can be added, deleted, or inserted by selecting 
the respective command under the Branch menu. 
 
If a new model is being developed or branches are being added from this view, the user can 
select ‘Add Branch’ under the Branch menu. When the first branch in a network has been 
entered, additional branches are added automatically by typing Enter at the end of the last row in 
the Branch Input View. Additional branches may also be added by typing Shift-Enter at any 
point in the Branch Input View.  
 
Once data has been entered in a particular cell the user can press either the Enter key or the Tab 
key to progress to the next cell.  This section allows the user to enter a description about each 
branch, allocate one of six ventilation symbols to the branch, enter a branch code for the type of 
branch, and specify surface status. The columns in all tabular views may be frozen, hidden or 
shown using tools under the View menu.  Figure 10 shows an example Branch Input View. 
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Figure 10: Branch Input View 

 

In the Branch Input view the Find option may be used under the Edit menu or via the Find 
Branch icon (binoculars ) on the tool bar.  These tools are different.  The Find option seeks up 
or down a selected column for an input text string.  The Find Branch option allows branches to 
be located either by entering from and to junction numbers or by finding the next occurrence of a 
particular junction number.  The Replace option allows the user to make global changes to the 
input data. 
 
3.3.3 Schematic View 
 
VnetPC Pro features a reversal function, which signals when airflow in a particular airway has 
changed direction from that which was intended.  In order for this function to work properly, the 
user must define each branch with junctions set up in the proper order (similar to fans and fixed 
quantities).  Once a simulation is executed, reversed airways will be tagged, as shown in Figure 
11. 
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Figure 11: Example Airways 

 
If desired, the ventilation network may be developed entirely within the Schematic View. 
Networks are established using functions obtained from the Tools menu or Tools Bar. This menu 
allocates different functions to the selection pointer. The following list of functions is available: 
 

 Selection Pointer 
 Create Junction 
 Create Branch 
 Plot Existing Junction 
 Create Fan 
 Create Contaminant 
 Create Label 
 Zoom Tool 
 Eraser Tool 
 Edit Tool 
 3D Spin Tool 

 
The Selection Pointer is the default option. This allows the user to highlight branches and by 
pressing the right mouse button change the attributes of those branches and access Template 
features. The network may also be resized or adjusted by dragging nodes around the screen using 
this pointer. 
 
The Create Junction option allows new junctions to be created prior to branch entry. The 
branches may then be inserted between the junctions using the Create Branch option. The 
creation of junctions is normally not necessary, because branches drawn in blank areas of the 
screen (using Create Branch) will automatically be assigned From and To nodes and numbers. 
These default numbers can be changed as required. Use of the Create Junction tool is generally 

Normal Airway 

Reversed Airway 
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restricted to the addition of nodes to identify shafts, raises and ramps. The user cannot create 
nodes in the section views. Nodes can only be input in the plan views. A branch may then be 
created between these existing nodes in a section view. Note that the user can select Junction 
Creation under the Tools Menu to change the starting node number (refer to Section 3.3.3.3). 
 
The Create Branch tool allows new branches to be drawn. The program automatically allocates 
junctions at the start and end of these branches, unless the user clicks on an existing node or 
intersects an existing branch. If an existing airway is used for a starting or termination point, then 
the branch will be divided and a new node will be added. The divided airway will be represented 
by one branch with the original branch data details, and a second new branch set at zero 
resistance. 
 
The Plot Existing Junction tool allows the user to plot the locations for junctions entered in the 
Branch Input View. This tool will not allow new junctions to be added, and just allows existing 
junctions to be plotted. 
 
The Create Fan tool allows fans or fixed quantity values to be allocated to existing branches. If a 
fan or fixed quantity already exists in the selected branch, then the fan or fixed quantity attributes 
for that branch are displayed. The direction of flow is based on the From/To node input data.  By 
selecting a branch with the Create Fan tool the following dialog box appears, shown in Figure 
12.  The user is then allowed to select a fan or fixed quantity for the assigned branch.   
 

 
Figure 12: Create Fan Dialog Box 

 
The Create Contaminant feature is handled in a similar fashion as the fan tool. In this case a 
dialog box will appear, illustrated in Figure 13, which requires the user to input either a 
contaminant volume flow or a concentration. The input concentration represents the 
concentration of the emission at that point in the airway. The user should not enter the total 
contaminant concentration, which will include any upstream sources. The output contaminant 
flow and concentration (evaluated by the program) will integrate all of the sources to determine 
actual concentration and volume based on a steady state condition. 
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Figure 13: Branch Contaminants Dialog Box 

 
The Create Label option allows labels to be entered for specific views or groups (layers). 
Attributes for these labels may then be changed using the Selection Pointer and the right mouse 
button or the Edit Tool. All the common Windows fonts are supported, and the text size may be 
adjusted over a large range for individual labels (see Figure 14). The orientation of the label can 
also be rotated through 360°. The user is allowed to specify a default text font and size (under the 
Preferences Menu/Default Font). 
 

 
Figure 14: Edit Label Dialog Box 

 
The Zoom Tool allows the user to resize the view rapidly. A section of the network may be 
expanded by dragging the mouse over the selected area while holding down the left mouse 
button. The user can also press the left mouse button to zoom-in, or the right mouse button to 
zoom-out. Tool buttons in the Schematic View also enable the user to zoom-in/out  and 
zoom all . These buttons are typically required to allow zooming when using a different tool 
for the mouse (such as Add Branch tool or similar).  The zoom –in/out tool is also enabled by 
scrolling the center wheel on the mouse.   
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The Eraser Tool allows the user to rapidly remove unwanted objects from the schematic. The 
tool will work with branches, nodes and text. A detailed Undo/Redo option ensures that erased 
data may be recalled in the event of a mistake. 
 
The Edit Tool allows the attributes of existing objects to be amended. The user must select the 
required node, branch or text to obtain the properties of the object. 
 
3.3.3.1 Levels and Perspective 
 
VnetPC has been developed to allow networks to be constructed in both the Schematic and 
Branch Input Views. The Schematic View allows the user to develop 3D models using a level 
scheme.  A level in VnetPC is defined as a group of branches falling within a user-specified 
range of z coordinates (may be thought of as a "Group" of branches that span a defined z range).  
It is recommended that the user initially specify a series of levels to cover the entire vertical 
extent of the network. The levels can be established with overlapping z ranges, such that a shaft 
or ramp level would represent a group of branches spread across the entire vertical extent of the 
mine.  
 
By selecting Groups under the Tools drop down menu the user can add, edit, or delete groups 
from the network in the Branch Groups dialog box as shown in Figure 15.   
 

 
Figure 15: Branch Groups Dialog Box 

 
From this view the names and default z-coordinates of any group can also be modified.  Within 
the Branch Groups dialog box the user can also select which levels to "Show" or "Hide," and 
which group is Active.  The Active group is in bold text and is on which new branches or text 
can be added.  
 
The level system allows the user to digitize the network in plan view on a level by level basis, 
which simplifies the construction of a complex 3D mine.  VnetPC incorporates multiple choices 
in viewing perspective for the network. 
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  Plan View 

  Long Section View 

  Cross Section View 

  Isometric (3D View) 
  Active Group (Level) 
  Selected Groups (Levels) 
 All Groups (Levels) 
  Edit Groups (Levels) Dialog Box 

 
Two of the views are illustrated in Figure 16 (3D) and Figure 17 (Cross Section). The active 
perspectives may be selected in the Schematic View from the View drop down menu or by 
selecting an icon on the toolbar.   
 

 
Figure 16: 3D View of a Metal Mine with 3D Spin Tool Active 
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Figure 17: Cross Section View of a Metal Mine 

The Plan View, Long Section View, Cross Section View and Isometric (3D) can illustrate all of 
the groups, selected groups, or only the active group.  The groups are designated in the Branch 
Groups dialog box illustrated previously in Figure 15.  The network can be manipulated in each 
of these views.  
 
The user can select the background color for the Schematic View.  The background colors are 
white, light gray, gray, dark gray, and black with the foreground in black or white.  The 
Background Colors dialog box is shown in Figure 15.  The selected background color will be 
retained for the saved current model.  If the user creates and new model, the background color 
will be the defaulted color of white with the foreground of black.   
 

 
Figure 18: Background Colors Dialog Box 
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The user can select which group is active using the Branch Groups dialog box or the drop down 
menu located on the toolbar in the Schematic view.  The user can see which group is active 
because it will be shown in the drop down box on the toolbar.  The option of viewing a single 
group allows the user to work with just that level in Plan, Long Section, or Cross Section View.  
When using the Plan view, Long Section View, Cross Section View, or Isometric (3D) the user 
may rapidly change the active group using the drop down menu as illustrated in Figure 19.    
 

 
Figure 19: Active Group Drop Down Menu 

 
Non-level airways, such as ramps and shafts may be entered in plan view or in a section view. 
The nodes should already exist when working in a section view (the start and end nodes), 
however, this is not necessary.  A branch can be drawn from an existing start node to a new node 
that is not attached to an existing branch.  In this case the coordinates of the “new” node will be 
established by taking the two coordinates shown on the graphical view for that point, and 
transferring the coordinate perpendicular to the graphical view from the start node to the “new” 
node. 
 
For example; if a branch is drawn form an existing junction in the cross-section view (Z-X) to a 
new node then the “Z” and “X” coordinates will be determined by the placement of the junction, 
and the “Y” coordinate will be taken from the start node.  
 
Once the junctions have been added, they may be moved across the entire vertical extent 
specified for that level by dragging the nodes within the sectional views. 
 
When entering nodes for a level the “x” value will default to the “z” coordinate that the user 
specified in the Branch Groups dialog box shown in Figure 14.  These default “z” coordinates 
may be adjusted in the Schematic View using the Selection Pointer to highlight a junction and 
the right mouse button to change attributes or by using the Edit Tool.  Another approach is to 
drag and drop the node when viewing the network in a section.  The “z” coordinate or the group 
number may be changed directly in the Junction Data View and the Schematic will be 
automatically updated. 
 
When using in the Isometric view (3D), the tools are limited to Edit Tool, Easer, Zoom and the 
3D Spin Tool .  The Selection Pointer may also be used to select branches or edit data but the 
user cannot draw or move branches in the Isometric view.  The Zoom tool allows the user to 
zoom in and out of the network.  The 3D Spin tool is used to interact with the model by 
"grabbing" and "pulling" the network in order to rotate it on the screen.  The network can be 
rotated through 360° in order to find the ideal viewing perspective. During the actual rotation 
using the 3D Spin Tool (while the user is holding down the left mouse button) the data on the 
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network will disappear for faster redraw.  When the user releases the mouse, the data will 
reappear onto the network in the new perspective. 
 
3.3.3.2 Grids and Snap to Grid 
 
VnetPC features gridlines that may be plotted on the x, y, and z axes.  Under the Preferences 
menu in the Schematic view select Grid Settings, the Grid Spacing dialog box will appear as 
shown in Figure 20.  This box allows the user to enter the spacing and origin for the gridlines. If 
the user selects a spacing that is too dense to display, a message box will appear and the user 
must input new data. A tag at the bottom of the dialog box allows a snap feature to be enabled or 
disabled. If enabled, then any new or moved nodes will be snapped to the grid. 
 

 
Figure 20: Grid Spacing Dialog Box 

 
3.3.3.3 Junction Creation 
 
When branches are added in the Schematic View, VnetPC will normally add node numbers in an 
ascending sequence starting from the lowest available number. By selecting Junction Creation 
under the Preferences Menu the user may disable the feature of using the lowest available 
number, and input a number to commence the node sequence.  Figure 21 illustrates where a user 
may define the next junction value.  The program internally checks node numbers to ensure that 
a node is only used once. 
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Figure 21: New Junction Number Dialog Box 

 
3.3.3.4 Importing DXF Files from CAD and Mine Planning Programs 
 
VnetPC allows the user to import a network or level from a CAD or mine planning program 
using a DXF file to transfer the data. Selecting File/Open and DXF Files under the Files of Type 
option allows data to be imported as a new VnetPC file. The user may also import data into an 
existing network using the Import DXF feature under the Tools drop-down menu of the 
Schematic View. A Layer Selection dialog box will appear and the user must select the 
ventilation schematic layer.  When the user selects a DXF file, VnetPC will examine the file for 
available layers and then prompt the user to select a layer to be used as shown below in Figure 
22.  The imported layer will created a new Branch Groups defaulting to the name the user 
specified for the imported layer.   
 
The user has the option to select a default branch type.  The selected defaulted branch type will 
be applied to all new imported branches created for the selected layer.  Branch type can be 
altered quickly following DXF import using the branch templates.  The units drop down menu is 
utilized when the DXF file and VnetPC model have different units.  For example, if a VnetPC 
model is developed in Imperial units but the DXF files are in SI units, the user will select SI units 
on the Layer Selection dialog box.  This function will convert the DXF files units to the VnetPC 
model units.    
 

 
Figure 22: DXF Import - Layer Selection 

 
Establishing a suitable DXF file requires a program that supports layers (such as AutoCADTM). 
The user should develop the network in the CAD program using only Lines, Polylines, and Text. 
The network should be developed on a unique (preferably new) layer, with an obvious name, 
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such as VnetPC.  The end point for each line or section of a polyline should represent a node 
location.  Care must be taken to ensure that the end and starting points of connected branches are 
at exactly the same coordinate (i.e. the nodes do actually connect). This would be done in 
AutoCADTM using the snap-to <endpoint of> or <intersection of> options. Failure to do this will 
result in the data being imported as separate lines rather than a network. 
 
The DXF import feature is not limited to CAD programs and will support DXF data from most 
mine planning software. Care needs to be taken to ensure that a level is contained in the DXF 
file, which represents the simplified schematic. If the mine plan is not simplified and centerline 
coordinates are imported for all the lines and polylines, then an extremely large network will 
result (for example, a coal mine could import every crosscut in the mine). 
 
3.3.3.5 Surface State 
 
In previous versions of VnetPC the user was required to manually connect all the surface nodes 
together using zero resistance dummy branches (to ensure full mesh closure).  This is not 
required in VnetPC Pro.  The user can now select the surface state of a branch during data entry 
as Intake, Return, or Neither.  It is important that the branch is entered in the correct direction 
(From and To nodes) such that the airflow will be positive.  Failure to do so will result in an 
error during execution, and a message box stating that one of the surface junctions is allocated in 
another branch (other than the specified surface branch). This results because the code is 
attempting to allocate a node as being on surface, when it is actually attached to more than one 
branch. All surface branches must be specified as either Intake or Return for the program to 
correctly close meshes and to execute without error.  
 
3.3.3.6 Branch Code 
 
VnetPC Pro allows the network to be color coded according to the type of airway, as well as 
parameter range. The user may select from a list of airway types; Default, Intake, Return, 
Neutral, Active and other user defined types. The Branch Codes colors allocated to these types 
may be changed under the Preferences menu Define Colors as shown in the dialog box in Figure 
23.  Colors can also be adjusted for the branch parameters in the Define Colors menu.  The 
option to enable the color codes can be selected under the Preferences menu; No Color, Use 
Color Range, or Use Color Code. 
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Figure 23: Branch Codes Dialog Box 

 

3.4 Fan Data 
 
The user may add fans in the Branch Input, Fan Input or the Schematic Views.  When a fan or 
fixed quantity of air is added to a branch, an F or a Q will appear in the F/Q/i column.  The Fan 
Input View will be updated to incorporate the new fan details. It is important that the user input 
the junction numbers in the expected direction of airflow for fixed quantity or fan branches.   
 
In the Branch Input View a fan is added by using the fan input icon  or double clicking the cell 
under the F/Q/i (fan, fixed quantity, inject/reject) column.  In the Fan Input View the user may 
add a fan by selecting Add Fan under the Fan menu or by clicking the add fan icon . In the 
Schematic View a fan or fixed quantity is added using the Fan Tool , and "dropping" the fan on 
the desired branch. 
 
3.4.1 Fan Location and Flow Direction 
 
A fan can be located in any branch that does not contain a fixed quantity. The branch junction 
numbers dictate the fan location. The order in which the junction numbers are entered defines the 
direction of the fan. To view or edit (or add to) the fans in the model, the user may use the Fan 
Input View. 
 
3.4.2 Fan Type 
 
Any fan can be entered with either a fixed pressure or with a characteristic curve of pressure 
against volume flow.  The fixed pressure and description of the fan can be entered in the Fan 
Data dialog box illustrated in Figure 24.  This dialog box also allows the user to enter an initial 
fan pressure if a fan curve is input, then this pressure is used as the starting point on the fan 
curve.  However, if a fan curve is not input, then the fan will be fixed at this pressure (regardless 
of quantity).  Users may turn the operating status for fans in VnetPC models without removing 
them.  When a fan status is turn “Off”, the program will use the entered branch resistance and it 
will not assume or added resistance to the airway created by the fan dampers closing or by a non-
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operating/idle fan.  To simulate the resistance of an idle fan or closed dampers, the user must 
modify the resistance in the branch for the arranged conditions.   
  

 
Figure 24: Fan Data Dialog Box 

 
The user may enter a fan curve by selecting Edit Curve from the Fan Data dialog box illustrated 
in Figure 24, or Edit Fan under the Fan menu in the Fan Input and Fan Results views.  Fan 
characteristic curves are registered by entering between two and twenty sets of pressure/airflow 
data points (see Figure 25).  These points should be chosen such that they adequately represent 
the full extent of the curve.  Users may add efficiencies for each of the fan curve points entered.  
The program will use the enter airflow, pressure, and efficiency to calculated the Motor Input 
Power.  The program assumes a linear line between any two points on the fan curve.  Fans with 
characteristic curves can be entered under fan data or retrieved from the fan data bank.  Once the 
points of the fan curve are entered into the Fan Data Sheet the user can select “OK” to 
incorporate the curve into the model or “Save” to export the curve to an external fan curve data 
base.  Note that the fan curves are unit-dependent and that the curves are converted if the unit 
conversion utility is used.    
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Figure 25: Fan Curve Dialog Box 

 
Using the entered fan characteristic curve, VnetPC Pro will generate a graphical display as 
shown in Figure 26.  After the simulation is executed, the predicted operating point with motor 
input power is plotted.   
 

 
Figure 26: Fan Curve Graphic Dialog Box 
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The user is also allowed to input data for multiple fans (series or parallel).  When multiple fans 
are selected the program will develop an equivalent fan curve based on series/parallel fan theory. 
The series and parallel fan data are shown in columns in the Fan Input and Fan Results views 
(see Figure 27 and Figure 28). 
 

 
Figure 27: Fan Input View 

 

 
Figure 28: Fan Results View 

 
After execution of the ventilation model, a warning message dialog box will appear if one or 
more fans are operating off their fan curves (see Figure 29).  The dialog box is a warning and 
does not affect the execution of the simulation.   
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Figure 29: Off Fan Curve Status Warning Dialog Box 

 
Fixed pressure fans are useful when modeling a known fan at a specific operating pressure or 
when modeling natural ventilation pressure (NVP). In the case of a fixed pressure fan, the fan 
curve should not be defined in the Fan Curve dialog box, only the fan pressure in the Fan Data 
dialog box should be input. 
 
3.4.3 Fan File Manager 
 
VnetPC incorporates a data archival program for the development, manipulation and storage of 
fan curves. This feature is called the Fan File Manager. The Fan File Manager allows the user to 
generate different fan files, each of which can hold many different curves.  Hence, the user may 
select to have just one fan file for all mine fans, or conversely, have separate fan files for each 
fan, perhaps with the different curve settings saved for each individual fan. 
 
The Fan File Manager is accessed directly from VnetPC by selecting File/Open and choosing a 
fan file (*.fdb extension). Application of the Fan File Manager is recommended when a large 
number of fans must be entered, edited or deleted from the fan database. The user may develop a 
new fan file by selecting File/New and choosing VnetPC Pro Fan Curve File as the new file type 
as shown in Figure 30.   
 

 
Figure 30: New Fan Curve File 

 
When a new file is opened, a screen will appear which allows the user to input a new curve from 
the Curve menu.  Once the fan points are entered, the file should be saved. 
 
For each fan curve entered into the Fan File Manager a reference density for the curve and a 
drive frequency need to be entered.  When the user brings the fan curve into the ventilation 
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model, the user can elect to change the reference density of the fan.  In this way a fan curve that 
is supplied from the manufacturer at standard atmospheric density can be saved and then brought 
into the VnetPC Program at a different density.  By shifting the fan operating density, the fan 
curve will also be shifted according to the ratio of the new density but will retain the original 
settings from the Fan File Manager.  After the fan curve is imported into the VnetPC model, the 
user may modify the frequency and density using the tool shown in Figure 31.   
 
With the push toward maximizing the efficiency of ventilation systems, MVS has incorporated a 
tool to modify the fan curve with respect to changes in fan rotational speed based upon the 
supplied frequency of a variable frequency drive (VFD).  When inserting a fan curve into the 
ventilation model, the user can elect to increase the frequency of the drive or decrease the 
frequency of the drive – thus changing the rotational speed for the fan and the fan characteristic 
curve.   
 
The user may save and import fan curves directly from the Fan Curve dialog box (within 
VnetPC) by clicking the Save and Import buttons.  Note that a fan data file must already exist to 
allow a curve to be saved to it.   
 

 
Figure 31: VFD Fan Adjustment 

 
3.4.3.1 Creating a Fan Curve Data Base 
 

a. Under the “File” menu select “New”. 
b. Select “VnetPC Pro Fan Curve File”, then select “OK” 
c. Select units, then press “OK” 
d. Under the “Curve” menu select “Add Curve” 
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e. Fill out the “Fan Curve Dialog Box”, with the Pressure and Quantity curves points 
and the Air Density and Frequency for the original curves, then press “OK” 

f. Repeat steps a through e to add as many curves as desired 
g. Under the “File” menu select “Save As”, then save the file like any Windows 

application with .fdb file type 
 
3.4.3.2 Importing a fan curve into a model 
 

a. Insert the fan into the model as described above, select the “Edit Curve” button on 
the “Fan Data” dialog box 

b. Select the “Import” button 
c. Find the Fan Curve Data Base File in the Windows dialog box 
d. Hi-light  the desired fan curve and select the “OK” button 
e. The fan curve will then be transferred into the Fan Curve dialog box. 
f. In the Fan Curve dialog adjust the Air Density and Frequency to actual mine 

conditions, then press “OK” 
 
3.4.3.3 Saving a fan curve from a model into the Fan Curve Data Base 
 

a. While in the “Fan Data Dialog Box” select the “Save” button 
b. Find the Fan Curve Data Base File in the Windows dialog box 
c. Select the method to add the fan curve to the data base (replace hi-lighted curve, 

or add to bottom) and select the “OK” button 
 

3.5 Fixed Quantity Tool 
 
The user may add a fixed quantity to a branch in the Branch Input, Fixed Quantity or Schematic 
views. In the Branch Input View the Fixed Quantity tool is enabled from the Branch menu, tool 
button, or by double clicking in the F/Q/i column.  This tool is used to simulate control of 
airflow, and will determine the resistance, pressure drop and orifice area for a regulator or the 
operating pressure of a booster fan.  A fixed quantity can be allocated to any branch that does not 
contain a fan. The user adds a fixed quantity in the Fixed Quantity View (see Figure 32) by 
selecting Add Fixed Quantity from the Branch menu, or by clicking the R\Fan tool button.  The 
fixed quantity tool is applied in the Schematic View using the Fan Tool option, and selecting 
Fixed Quantity rather than Fan when prompted as shown in Figure 33. 
 

 
Figure 32: Branch Input Fixed Quantity View 
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Figure 33: Schematic View Fix Quantity 

 
The Fixed Quantity View will automatically be updated according to the information entered in 
the Branch Input or Schematic Views.  The input data type (1-4) dictates the resistance of the 
branch. This resistance is usually the natural resistance of the airway without a regulator or 
booster fan. Upon execution, the program calculates the regulator resistance and orifice area or 
the pressure of the booster fan required to achieve the specified airflow.  Negative integers 
cannot be entered and it is necessary to change the branch node numbers if airflow is to be 
reversed. 
 
Within the fixed quantity dialog box there is the option of specifying the branch as an Inject or 
Reject branch.  This tool is used to add or remove air from selected junctions to account for 
compressibility effects, ducts, compressed air lines, or areas of the facility not otherwise 
represented in the network.  For example, as air passes down a shaft it is compressed due to 
autocompression.  Since VnetPC assumes incompressible flow, this compression may need to be 
modeled separately by removing air (rejecting) from the model at the base or along the length of 
the intake shaft.  Note that air will probably need to be injected in deep mines to account for the 
effects of expansion as the air rises. 
 

3.6 Contaminant Distribution Analysis Data 
 
The contaminant distribution utility incorporated in VnetPC utilizes results of the network 
exercises to evaluate contaminant concentration and gasflow distributions. The user specifies 
locations and magnitudes of contaminant sources (refer to Figure 34). The program uses airflows 
from the last execution of the ventilation simulation to calculate contaminant flow assuming 
steady-state conditions. The program also assumes fully turbulent flows with complete mixing. 
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Figure 34: Contaminant Data View 

 
Identifying the branches representing the location of the contaminant emissions lets the user 
specify the sources.  Under the Contaminant Data View the branch numbers, junction numbers 
and branch description will appear the same as in the Branch Input View.  These values cannot 
be changed in the Contaminant Data View.  Contaminant sources are entered as quantities or 
concentrations in the various columns.  Valid entries for emission rate must be positive and less 
than 10.0 kcfm or m3/s.  Data can be entered to four decimal places. Contaminant data is entered 
in the Schematic View using the Contaminant Tool, and clicking on the branch where the 
contaminant will be added. The input concentration represents the concentration of the emission 
at that point in the airway. The user should not enter the total contaminant concentration, which 
will include any upstream sources (this value is computed by the program). 
 
The contaminant distribution analysis routine requires that branches representing intakes 
carrying fresh air directly from the surface be identified.  VnetPC uses those branches selected as 
Intake from the Branch Input and Schematic Views (used for mesh closure as well as 
contaminant analyses).  The contaminant execution is conducted by selecting Execute 
Contaminant from the Tools Menu (in any view), or pressing the Execute Contaminant button, 

 located on the Tool Bar. 
 

3.7 Branch Template 
 
The Branch Template feature equips users with the ability to apply data to individual or multiple 
branches.  Users define individual branch data properties using a Branch Template (see Figure 
35).  After a branch template is defined, users may apply this to a single branch or multiple 
selected branched.  Users can locate the list of templates using the “Go To” drop-down menu and 
selecting Branch Template.   
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Figure 35: Branch Template View 

 
Branch Templates allows users to rapidly apply either complete branch data or selected branch 
data.  Branch Templates are designed for users to rapidly develop models and have the ability to 
selectively modify individual fields of data.  Using the Template Fields (see Figure 36), users 
can select which fields of data will be changed when the template is applied.  The Template 
Fields dialog box can be accessed by choosing “Select Fields” from the Template drop-down 
menu is in the Branch Template view.  This feature will only modify the selected fields.  For 
example, a user creates multiple branches with varying resistance data types but would like to 
modify the Branch Code to all the same.  The user will select to apply the Branch Code and 
ignore the other available fields.   
 

 
Figure 36: Branch Template Fields Selection Dialog Box 

Branch Templates can be added to a ventilation model in the Schematic View and Brach Input 
View.  In Schematic View, a user may select a branch or branches using the Selection Pointer 
tool.  Using the Selection Point right click on a selected branch a selection dialog pop-up will 
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appear where the user may select “Apply Template”.  A Select Template dialog box will appear 
as shown in Figure 37.   
 

 
Figure 37: Select Template Dialog Box 

 

3.8 Transient Time Calculator 
 
The transient time calculator is used to calculate how long it will take for a particle to travel 
through a defined section of the network.  This time is determined with the air velocity 
calculated from the airflow quantity, the area of the openings, and the length of the branches.  
The calculator is accessed through Tools drop down menu selecting Transient Time.  In this 
dialog box shown in Figure 38 the user must start by entering a series of junctions to create a 
path, which will be traversed by the particle.  After this is done, the user must enter the average 
cross-sectional area and length of the individual branches in either the Branch Input View or 
Schematic View.  The program will extract the pertinent airflows, lengths, and areas from the 
branch data.  Once the user has input the dimensions of the branches, the total time to traverse 
the path is computed by pressing the Calculate button on the Air Transient Time Calculator 
dialog box. The user can store sequences that will be used more than once by using the Sequence 
List button available on the Transient Time dialog box. 
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Figure 38: Transient Time Calculator Dialog Box 

4. Operating the Program 
 

4.1 Manage Network Files 
 
VnetPC utilizes conventional Windows protocol for managing files.  VnetPC files are searched 
for under the designated .vdb file extension and fan files under the .fdb extension.  Files may be 
accessed from the host computer or through a network system. 
 

4.2 Data Conversion – Previous VnetPC Versions 
 
VnetPC allows import of files from the previous version of VnetPC (VnetPC 2000, VnetPC 
2003, and VnetPC 2007).  To convert a file, the user opens it normally, executes the simulation, 
and then saves the file in the new VnetPC Pro format.  It is important that the file to be converted 
(from VnetPC for Windows) has coordinates specified for all the junctions in the network.  If the 
user has not specified coordinates for all the nodes, then errors will appear when the file is 
opened.   
 

4.3 Execute Ventilation Simulation 
 
Executing the program is accomplished by selecting the Tools Menu on the menu bar and then 
choosing “Execute Simulation”.  This should only be done when the branch, fan, and descriptive 
data for the network have been fully entered.  When the program has finished execution, each 
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view, and any previously accessed windows, will be updated with the current information. 
Execution may also be initiated by hitting the Execute Simulation tool button (denoted by a 
calculator symbol ) on the toolbar in any view. The contaminant simulation must be executed 
separately after the airflow simulation has been accomplished. 
 
Unlike the previous versions of VnetPC, relative pressure analyses are conducted during every 
execution of the code (the user does not have to tag on or off).  Relative pressure is the difference 
in pressure from each node to the user specified reference junction.  This reference is often 
useful to determine relative pressure difference between two unconnected junctions.  Output of 
the relative pressure is viewed on the schematic, in square brackets, or in the Junction Data 
View. The user can select whether to view or hide the relative pressure data on the Schematic 
using the Preferences drop down menu and selecting Relative Pressure. 
 

4.4 Viewing the Results of a Simulation 
 
Once the program has been executed, the results of a simulation may be viewed using the Branch 
Results, Fan Results, Fixed Quantity, Schematic or the Contaminant Data Views.  The output 
data can also be sent to a Plotter or Printer.  Any computational errors are automatically listed in 
the Error dialog box immediately following execution. This dialog box may also be accessed 
from the Tools Menu in any view. 
 
4.4.1 List Errors 
 
VnetPC identifies four basic execution errors (see Figure 39). 
 

 
Figure 39: View Errors Dialog Box 

 
Once an error has been identified in a branch, the program does not stop execution but continues 
operation until it converges on a solution. The following errors may occur: 
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4.4.1.1 Too Many Fixed Quantities 
 
This error message arises if the input data file contains an excessive number of fixed quantity or 
inject/reject branches. If fixed quantity branches are used excessively in interconnecting 
branches, some fixed quantities will be omitted from the mesh selection process. Only one fixed 
quantity branch is allowed per mesh. In the case of this error the Branch Input View should be 
modified to decrease the number of fixed quantity or inject/reject branches before the network is 
re-executed. 
 
4.4.1.2 Branch Omitted in Mesh Selection 
 
The branches that appear under this heading in the error screen were not included in the mesh 
formation process and were omitted. The truncated network is still evaluated, but without the 
omitted branches. Junctions connected to only one branch (e.g. dead-end branches) usually cause 
this error. If this message appears the network should be scrutinized and amended. 
 
4.4.1.3 No Mesh Found for Branch 
 
This message arises from the basic branch and mesh selection processes. The minimum number 
of basic branches and meshes required for every network is defined as (number of branches - 
[number of junctions + 1]).  If, for any reason, this value is not attained during the basic branch 
selection process, or the mesh selection process, this error message will occur.  The program is 
designed to continue evaluation of the network based on the number of meshes attained. 
 
4.4.1.4 Iteration Limit Exceeded 
  
The number of iterations for the Hardy Cross process used to solve the network is limited to 
1000 iterations. If, after 1000 iterations a balance has not been reached, the program terminates 
and the values obtained after the 1000th iteration are listed as the results in the output. 
 
This error is most often caused by excessive use of very high resistance branches. The network 
data should be checked and the schematic viewed to identify any erroneous branches. The 
iteration limit is set in order that the computer does not spend excessive time performing 
iterations trying to resolve an unsolvable network. 
 
4.4.1.5 Locate Error in Schematic Tool 
  
In the event an Error List dialog box appears after execution, the user may highlight the error in 
the list and push “Locate in Schematic”.  The selected branch in the error list will become 
highlighted as shown in Figure 40.  The error list will remain on the screen to assist the user with 
locating the errors in the ventilation model.   
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Figure 40: Locate in Schematic Error List 

 
4.4.2 Fan Operating Points 
 
The Fan Results View lists the output operating points for the fan(s) in the model.  It gives the 
operating pressure, airflow, parallel/series configuration, required power, annual operating cost, 
curve status, fan status, and a description of the fan.  If the user supplies a fan curve then the Fan 
Results View also lists whether or not the fan is operating on the curve.  The user cannot modify 
the Fan Results View. 
 
4.4.3 Branch Results 
 
The Branch Results View lists the output in a spreadsheet format (see Figure 41).  Data includes 
the branch number, junction numbers, airway total resistance, airflow, pressure drop, air power, 
velocity, branch description, and a symbol indicating whether the branch contains a fan, 
regulator or booster fan (FRB).  The output sheet is designed such that it is easy to read and 
simple to scroll through. The user cannot modify the data in the Branch Results View.  The total 
resistance column reports the total of the branch input resistance and the resistance of any 
regulation resulting from fixed quantities.  To obtain a breakdown of these two resistance values 
it is necessary to examine the Fixed Quantity View. 
 



 44

 
Figure 41: Branch Results View 

 
4.4.4 Fixed Quantity Information 
 
Fixed quantity input and output data are shown under the Fixed Quantity View (refer to Figure 
32).  This view lists branch number, junction From/To, whether the branch is designated as 
inject/reject (I/R), booster pressure, regulator resistance, regulator orifice area, input branch 
resistance, total resistance of the branch (if regulated), and description for the fixed quantity. 
 
4.4.5 Displaying the Results using the Schematic 
 
The on-screen schematic is perhaps the most user-friendly way to input and view data. 
Ventilation networks can be entirely developed within the Schematic View, and it provides a 
rapid means of viewing the network results.  In the Schematic View different parameters may be 
plotted onto the network using the Preferences Menu. 
 
4.4.5.1 Preferences Menu 
 
The Preferences Menu allows the user to select which output parameters are to be shown and 
how to show them. The key features from this menu are listed below; 
 
Parameter 
 
This command allows the user to identify the desired parameter to be displayed on the schematic. 
The eleven choices are: 

 
• Quantity  
• Velocity  
• Pressure Drop 
• Air Power Loss 
• Operating Cost 
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• Contaminant Flow Results 
• Contaminant Concentration 
• Resistance 
• Branch Number 
• Line Plot 
• Dual Parameters  
 
Each parameter may be plotted separately for legibility or the user may use the Dual Parameters 
feature.  Dual Parameters allows the user to select two types of parameters to be displayed on the 
schematic and the user may select the text color for the selected parameters being displayed.   
 
The user may rapidly change the parameters being displayed on the schematic using the quick 
select tool bar shown in Figure 42.   
 

 
Figure 42: Parameter Quick Select Tool Bar 

 
Dual Parameters  
 
The Dual Parameters feature enables users with the ability to display two parameter outputs on 
the schematic simultaneously.  Users can access the Dual Parameters through the Preferences 
drop-down menu, then selecting Parameters (see Figure 43).   
 

 
Figure 43: Selecting Dual Parameters in Schematic View 
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After selecting Dual Parameters from the Preferences drop-down menu a Select Dual Parameters 
dialog box will appear (see Figure 44).  With the drop-down menus for parameter and color, 
users may select with two parameters will be displayed on the schematic.  The text colors 
displayed on the schematic are user defined.  After the user selects the parameters and colors 
press “OK”.   
 

 
Figure 44: Select Dual Parameters Dialog Box 

 
Figure 45 is an example of Dual Parameters being displayed on the ventilation schematic in 
VnetPC Pro.  For this example, Quantity color coded Bright Blue was selected for Parameter 1 
and Pressure Drop color coded Bright Red was selected for Parameter 2.   

 
Figure 45: Example of Dual Parameters Displayed on a Ventilation Schematic  
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Define Colors 
 
This command allows color ranges to be specified for the different parameters. There is a choice 
between fourteen colors, black, and white.  For a specified parameter range, the network 
branches containing values within that range will appear on the screen and printer/plotter in the 
specified color.  A legend can be printed detailing parameter ranges and color assignments.  This 
option is useful to help identify high pressure drops or excessive operating costs in the branches 
within the network.  If the specified printer does not have color, then the legend will 
automatically be omitted from the output.  Within this group there is also the option of setting a 
color for junction numbers and relative pressure. 
 
The user may also select to define colors for the Branch Code, as opposed to a parameter range.  
This allows colors to be assigned for different types of branches, which can be specified from 
certain categories during entry of the input data.  The basic branch types available are Default, 
Intake, Neutral, Return, Active, and several user defined branch labels.  Within the Preferences 
Menu the user can select whether to use branch colors based on parameter range, branch code, or 
whether to disable the color option entirely. 
 
Junction Range 
 
This command allows the user to display a selected series of nodes.  This is particularly helpful 
when sections of the schematic are no longer in use, and the user wishes to show only relevant 
areas.  The total junction range is from 1 to 10000. 
 
Letter Size 
 
This command allows the user to adjust the size of the parameters plotted on the schematic. It is 
often useful to customize the lettering size to fit the schematic so that the labels are easily read. 
The range of font sizes is as follows; screen 4 to 12 point, printer 4 to 14 point, and DXF 1 to 
200.  These fonts are actual sizes, and do not vary according to coordinate range. 
 
Junction Numbers 
 
This command toggles the junction numbers on and off in the Schematic View.  This is helpful 
when branch values and node numbers become cluttered.  Removing the junction numbers may 
help to clarify the drawing. 
 
Relative Pressure 
 
The relative pressure is given in square brackets next to each junction. This feature is now 
available to be toddled on and off in the Schematic View and does not have to be tagged during 
execution (as with previous versions of VnetPC). 
 
Symbols 
 
This command toggles on and off any symbols the user has specified in the network. 
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Display Labels 
 
This command toggles on and off the labels created in the Schematic view.   
 
Show Inject/Reject Branches 
 
This command toggles on and off any inject/reject branches that the user has specified in the 
network.  The branches are still included in the calculation, but are not shown in the Schematic 
View. 
 
Line Properties 
 
This command allows the user to change the thickness of the branches to be displayed in 
Schematic view and printed with the Line Width as illustrated in Figure 46.  The Highlight 
function allows users to increase the thickness of branches.  The Highlight function can be used 
based on the Selected Branch, Active Group, or Contaminates.  An example of the Highlight 
function is shown in Figure 47.   
 

 
Figure 46: Line Highlight Dialog Box 
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Figure 47: Example of Line Highlight for a Metal Mine 

 
4.4.5.2 Zoom Menu 
 
With the Zoom command the user can either zoom-in or zoom-out within the schematic.  The 
user can also select a window to zoom by engaging the Zoom Tool under the Tools Menu.  Once 
a window has been zoomed it can be reduced by using the “Previous” or All command on the 
Zoom Menu.  The “Previous” command zooms to the previous level.  The All command resizes 
the extents of the network to fit on the screen.  There is also a Zoom All tool button present in 
the Schematic View.  Panning from one portion of an enlarged schematic to another can be 
accomplished by utilizing the scroll bars, arrow keys on the keyboard, or pressing down the 
center mouse wheel.  When panning, the program will redraw the schematic between each pan. 
 
4.4.5.3 Junction Data 
 
In order to display or print the on-screen schematic, coordinates must be assigned to each 
junction.  Coordinates are either entered manually or copied (from a spreadsheet) into the 
Junction Data View (see Figure 48), imported from a DXF file, or digitized using the system 
pointer within the Schematic View.  In the Junction Data View the junction numbers appear on 
the left column, and X, Y and Z coordinates are shown in the adjacent three columns.  The 
column marked Branches Attached indicates how many branches are connected to each node.   
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Figure 48: Junction Data View 

4.4.5.4 Ventilation Structure Symbols 
 
Ventilation structure symbols are entered in either the Schematic or Branch Input views.  From 
the Schematic View the user enters a symbol in the Branch Data dialog box.  In the Branch Input 
View the user selects from a list of six symbols in the Symbol column.  These symbols can be 
toggled on/off by tagging Symbols under the Preferences Menu.   
 
4.4.6 Printing Output Data 
 
The output data (tabular views) and the schematic can be directly printed by either clicking the 
print icon on the tool bar, or by selecting the Print Active View subheading under the File Menu.  
A dialog box will appear that allows the user to print in draft or final mode.  In draft mode lines 
are placed around the header of each page being printed. In final mode each output cell in the 
tabular views is bordered which requires additional printing time.  The user can also specify a 
print range in the Print Dialog box.  Printing a range of branches is possible by checking the 
Branch Range box and specifying those branches to be printed. 
 
Prior to printing the output or the schematic, it can be previewed on the screen by selecting the 
Print Preview subheading under the File menu.  The printer can be reconfigured by selecting the 
Print Setup subheading under the File Menu.  This can be particularly helpful when changing the 
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paper orientation from portrait to landscape.  Often the schematics and branch input data are 
better represented by printing in landscape mode. Different output devices can be specified using 
the Print Setup option as long as the device driver has been loaded within Windows.   
 
4.4.7 Plotting Output Data 
 
Plotting is managed the same way as printing, except that the device driver selected in the Print 
Setup will be a system plotter.  VnetPC allows plotting to a complete range of plotters supported 
by Windows.  Providing that the plotter device driver has been loaded in the Windows Setup, 
VnetPC should recognize and communicate with any plotter. 
 
4.4.8 DXF File Generation 
 
The user can export the schematic to a DXF file.  This feature is accessed through the Schematic 
view using the Tools/DXF file menu.  A dialog box will appear for the user to Save As in DXF 
format, then another dialog box will appear prompting the user to select a parameter to export, 
illustrated on Figure 49.  This feature allows the users to define which parameter or no 
parameters to be exported.  The exported DXF file layers will be named (automatically) to allow 
the user to easily recognize what data is contained on each layer. 
 

 
Figure 49: DXF Select Information Dialog Box 

 

4.5 Changing the Appearance of a Table View 
 
All of the columns in the table views can be changed in any number of ways.  The columns and 
rows can be rearranged, widened or narrowed, removed or added.  The columns can be easily 
rearranged by clicking on the column or row header with the left mouse button to hi-light it, then 
by clicking on it and dragging it to its new position. The column width can be widened or 
narrowed by clicking on the column separators in the column header and dragging it in one 
direction or another.  The columns can be removed or added by selecting Columns from under 
the View menu on the tool bar.  This is useful so that the items on a view can be limited to only 
those parameters actually used in the simulation.  Figure 50 shows the columns dialog box for 
the Branch Input View.  Users may view all the groups, selected groups, or active group in the 
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Branch Input and Branch Results views as shown in Figure 51.  This function allows the user 
sort the data by groups for easier viewing.     
 

 
Figure 50: Columns Dialog Box for Branch Input View 

 

 
Figure 51: Selected Group being Displayed in Branch Input View  
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5. Tutorial 
 

For additional information on the many tools and features mentioned in this section, refer to the 
previous sections in this document and the program “Help Tools”. 

 

5.1 Introduction 
 
This tutorial describes how to establish a ventilation model in VnetPC using AutoCADTM (or a 
DXF file generated by another mine planning or CAD package) to establish a network 
schematic.  Additional help about other VnetPC features can be found in the Contents selection 
of the Help menu in the VnetPC Program.  The following sections detail how to establish a 
ventilation schematic in AutoCADTM and create a new VnetPC file from the data.  The step by 
step process provides the user with an in-depth look at how to get started. 
 

5.2 Setting Up the Model in AutoCAD 
 
5.2.1 Adding the Ventilation Layers 
 
The AutoCADTM program allows users to create layers.  It is suggested that for each 
section/component of the mine, a new layer be created for the network schematic (e.g. set up 
new layers for each level, or the ramp, shaft, etc.).  An example Layer Properties Manager dialog 
box has been copied out of AutoCADTM and is shown in Figure 52 to demonstrate this feature.  
The original drawing layers are 1400, 1600, 1800, 1920, and 2000.  The layers 1400VENT, 
1600VENT, 1800VENT, 1920VENT and 2000VENT were created for the purpose of importing 
a schematic into the VnetPC Program. 
 
Each of the layers denoted with the suffix VENT, will contain a portion of the overall schematic.  
When transferring the schematic to VnetPC, each level must be individually imported.  Because 
VnetPC uses the digital exchange format (DXF), it can import files from other software 
applications that utilize a graphical image to present data.  An example metal mine is shown 
below with each layer turned on to show how they overlay.  This procedure can be done with 
multiple files (one for each level instead of a layer); however, it can be more efficient to develop 
a mine map in one DXF file with multiple layers (as shown on Figure 53). Figure 54 shows a 
single level of the mine.  This level will be used to start a schematic drawing. 
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Figure 52: AutoCADTM Layer Properties Manager Dialog Box - copied from AutoCAD 2010TM 

 

 
Figure 53: Drawing of Metal Mine Airways (Plan View with multiple levels active) 
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Figure 54: 1400 Level 

 
5.2.2 Drawing the Schematic (Line Diagram) 
 
When drawing the schematic it is important to ensure that each branch is connected.  Do not 
terminate a branch and then begin the next branch without ensuring that the two are 
connected.  In AutoCADTM, it is suggested that the user enable a running object snap such as 
[endpoint] or [intersection] to connect the branches.  The user may develop the network using 
Lines, Polylines and Text.  The schematic will be drawn on the VENT layer while displaying 
both the VENT layer and the corresponding mine level (basically overlaying the mine map).  The 
schematic will be a line diagram, with each line representing an airway.  When drawing the 
schematic, it may be helpful to think of the lines as centerlines.  Not all airways need to be 
drawn.  An excessive number of airways can result in model inefficiencies and lead to a greater 
potential for errors.  Large networks require more time to execute and will not necessarily 
provide increased accuracy.  The AutoCADTM schematic does not have to be exact, since it can 
be adjusted in the VnetPC Program for evenness, spacing, and alignment.   Figure 55 through 
Figure 59 illustrate the four levels with the network lines drawn on overlying layers. 
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Figure 55: 1400 Level with Wire Frame Drawn 

 

 
Figure 56: 1600 Level with Wire Frame Drawn 
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Figure 57: 1800 Level with Wire Frame Drawn 

 

 
Figure 58: 1920 Level with Wire Frame Drawn 
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Figure 59: 2000 Level with Wire Frame Drawn 

 
After the line diagrams are established for each level, the ramp is then identified.  VnetPC does 
not treat each of these layers as a distinct “level”, although in some cases it can be thought of in 
this manner.  Instead, each layer imported to VnetPC is identified as a Group of branches with 
similar general characteristics.  When all of the branches have the same general elevation then 
they can be considered a Level.  However, since a ramp will have various elevations for each set 
of branches, it may be easier to think of them as a Group.  The branches drawn for the ramp are 
shown on Figure 60. 
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Figure 60: Close-up of Branches Drawn in Ramp 

 
The ramp is traced using large line segments.  Wherever the ramp connects to a level, the 
schematic wire frame is connected to the intersection previously drawn as displayed in Figure 
61. 
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Figure 61: Ensure all Branches are Connected 

 
The [end entity] tool in AutoCADTM is used to ensure that all of the level connections are in 
fact terminated at the endpoint of the line segments.  Once the wire frame diagrams are drawn 
they will look like the pictures in Figure 62 through Figure 66 in plan view. 
 

 
Figure 62: 1400 Level VnetPC Pro Schematic  
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Figure 63: 1600 Level VnetPC Pro Schematic 

 

 
Figure 64: 1800 Level VnetPC Pro Schematic 

 

 
Figure 65: 1920 Level VnetPC Pro Schematic 
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Figure 66: 2000 Level VnetPC Pro Schematic  

 
5.2.3 Exporting the DXF File 
 
Once the line diagrams are completed, a DXF file needs to be generated.  This is done in 
AutoCADTM by selecting the Save As option listed under the File menu.  Be sure to select the 
DXF option under the File Type drop down menu.  The dialog box is shown in Figure 67 for the 
tutorial example. 
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Figure 67: AutoCADTM Save Drawing As Dialog Box 

 
Once a DXF file has been generated the AutoCADTM program can be closed. 
 

5.3 Working in the VnetPC Program 
 
5.3.1 Model Information View 
 
The New File View is the first view presented to the user when a model is opened.  For a model 
to be initiated the user selects the New option from under the File Menu which brings up a dialog 
box illustrated in Figure 68.  This dialog box provides the user the choice of generating a fan 
data base or VnetPC document. 
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Figure 68: VnetPC New Model Dialog Box 

 
In this case, the user will choose a VnetPC Pro File.  Then another dialog box will appear 
prompting the user to select units as shown in Figure 69.   
 

 
Figure 69: Select Units Dialog Box 
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A blank model will appear with the Model Information view.  In the Model Information View, 
the user provides general data for the model as shown in Figure 70.  
 

 
Figure 70: Model Information View 

 
The model title and any particular description can be entered to further identify the purpose of 
the simulation.  The unit basis is selected as either Imperial or SI and can be changed from this 
view.  The user can enter the average power cost and fan efficiency in this view.  This data is 
used to calculate fan power consumption, air power cost of each branch in the network, and 
shock losses.  A reference junction is also selected.  This junction is usually associated with a 
surface condition.  A relative pressure table will be calculated relative to this point. 
 
5.3.2 Schematic View 
 
The Schematic View is obtained by selecting Schematic from the Go To menu. 
 
5.3.2.1 Importing the Schematic 
 
The screen will be blank as no schematic or model has yet been input.  From under the Tools 
Menu the user will select Import DXF (see Figure 71) to bring the network into VnetPC. 
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Figure 71: Importing the DXF File into VnetPC 

  
Once the user selects the Import DXF tool, a standard Open file dialog box will appear 
prompting the user to identify the DXF file to be imported.  The user then selects the DXF file.  
The Layer Selection dialog box shown in Figure 72 will then appear prompting the user to 
identify the layer to be imported.  In this case the VENT and RAMP layers will be imported.  
The layers can only be imported one at a time.  At this point the user may select the default 
branch type will be imported as either R, P/Q, k Factor, or R/L.  The units drop down menu is 
utilized when the DXF file and VnetPC model have different units.  For example, if a VnetPC 
model is developed in Imperial units but the DXF files are in SI units, the user will select SI units 
on the Layer Selection dialog box.  This function will convert the DXF files units to the VnetPC 
model units.   
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Figure 72: Layer Selection Dialog Box 

 
As the layers are imported, the schematic (Figure 73) will begin to appear on the screen.  If the 
schematic does not begin to appear, select “All” from the Zoom menu or the “Zoom All” button 
on the Toolbar.  This will show the extents of the schematic on the screen.  If a junction is 
connected to more than one branch the junction will be illustrated with a circle, if the junction is 
connected to a single branch the junction will be represented with a triangle as illustrated in 
Figure 73.   
 

 
Figure 73: Plan View of Imported Schematic 

 
Initially the schematic may seem complex and hard to understand; however, each node can be 
easily moved after the import process is complete.  Furthermore, the layers or groups can be 
hidden from view to simplify the screen data.  Once all of the layers have been successfully 
imported into the program, their general group attributes need to be defined.  When branches are 
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imported into the program the junction numbers are automatically defined.  This numbering is 
conducted sequentially and progresses from right to left across the network. 
 
5.3.2.2 Defining Group Attributes 
 
Each layer or group has a set of general attributes, which separate it from the other groups.  In 
this case each group represents an individual level having a discrete range of elevation.  For 
example, the group 3120VENT has a range of elevations from 3115 to 3125 which separates it 
from the others groups. Any changes to a group’s attributes may be made by clicking on the 
“Groups” item on the Tools Menu (shown on Figure 74). 
 

 
Figure 74: Junction Groups Dialog Box 

 
The Junction Groups dialog box will appear which allows the user to select the group to be 
modified from the list provided.  In this case we will first modify the attributes of the group 
2700VENT.  To modify this group select any of the group attributes shown and make any 
wanted changes.  
 
The RAMP group provides a little more challenge in that it is not a level; rather it is a group that 
spans a wide range of mine levels.  For this reason, the ramp is often created within VnetPC by 
connecting the different levels with a single line representing a section of ramp between two 
points.  If you choose to create your ramp in 3D, the z-coordinate values will be automatically 
imported with the rest of your model.   
 
If desired, group names can be modified.  Initial names are defaulted to the layer names imported 
from AutoCADTM.  Group 1, entitled “Default” is the initial default level.  This level can be 
deleted or re-named to suit the user.  If this level is renamed, then the z coordinates for this 
level should be modified from 0 to the desired level elevation.  If these z coordinates are not 
changed, then the zoom-all command will not display the schematic when in the cross-section 
views (the difference in elevations 0 to 3125 will be too great to show on the screen).  It is 
important to note that only the active group can be modified by the user (the user cannot 
construct branches in non-active groups).  Furthermore, only one group can be active at any one 
time, although all or multiple groups can be displayed. 
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5.3.2.3 Viewing the Model Cross-Section 
 
The schematic Cross-Section can be viewed by selecting a button on the tool bar.  The following 
buttons automatically appear on the tool bar and are used to change the view of the schematic. 
 

 Cross-Section View View all groups 

 Long-Section View  View only the selected groups 

 Plan View View the Active Group in Plan View 

 Isometric (3D) View  Change the selected groups, turn 
 

When viewing single levels, the drop down menu on the tool bar can be used to select which 
group to view and edit with the mouse.  When viewing all of the groups in plan view, the drop 
down list can be used to specify which group is active 

 
If the ramp was created in 2D, the elevations for the nodes in the RAMP group can be entered in 
either one of two ways.  In the sectional views, existing nodes can be moved anywhere in the 
vertical or horizontal planes with the mouse, or each node can be selected individually and an 
elevation assigned to it.  Individual nodes can be selected and an elevation assigned to them in 
the isometric view.  In this case each node will be selected and the elevation modified 
individually.  The junction is edited using the “Edit” icon  located on the Toolbar or by 
selecting the “Edit” option under the Tools menu, and then clicking on the junction.  The Edit 
Junction dialog box will appear allowing the user to change the location of the junction (see 
Figure 75). 
 

 
Figure 75: Edit Junction Dialog Box 
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Figure 76 shows the modification of the elevation of node 32 on the ramp from 1800 Level to 
1600 Level.  When a group is imported without an elevation defined, then all of the nodes in that 
group will be defaulted to the mean elevation value.  However, the elevation values can be easily 
modified to allow the ramp to extend from the base of the model to the upper levels (as displayed 
on Figure 76). 
 

 
Figure 76: Completed Cross-Sectional View of Schematic 

 
Because this model was developed on a two dimensional plane in AutoCADTM no elevations 
were imported into VnetPC. If elevations were used in the AutoCADTM drawing they would 
have been imported and the z-coordinates would have been defined.  In the AutoCADTM drawing 
no branches were given for the intake and exhaust shafts.  These can be added directly in VnetPC 
(the junctions should already exist on the levels). 
 
5.3.2.4 Viewing and Editing the Schematic in 3D 
 
The VnetPC Program incorporates a feature that allows the user to view and edit Branch Data 
and Junction the schematic in 3D (isometric).  The user can actively rotate the schematic and 
zoom in/out on the schematic.  To switch to the 3D perspective, the user selects the  button 
from the tool bar.  The schematic can be rotated by using the 3D Spin Tool . The user can 
“drag and drop” with the mouse to rotate the schematic.  If portions of the schematic rotate off 
the edges of the screen the user can automatically resize the schematic to fit the screen with the 
Zoom All button  located on the tool bar or scrolling the center mouse wheel.  Figure 77 shows 
the schematic rotated to allow the branches to be viewed and edit more clearly.   
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Figure 77: Rotated 3D Schematic 

 

5.4 Adding Branches to the Schematic 
 
Branches can be added to the ventilation model directly in the Schematic View (or in the Branch 
Input View).  Branches that are added through the schematic will automatically show up in the 
Branch Input View with resistance values defaulted to zero.  The user selects the Create Branch 
option located under the Tools Menu or the Create Branch icon  on the Toolbar.  To add a 
branch, click on the branch origin (from node), then holding the left mouse button down, move 
the mouse to the branch termination point (similar in operation to drag and drop features of other 
Windows based programs).  A segment of the exhaust shaft is being inserted in Figure 78.  If 
there is an existing node in close proximity to either of the two nodes (From/To) then the branch 
will automatically “snap” to those junctions. If the user chooses to either begin or terminate a 
branch by intersecting an existing branch, then the existing branch will be split, and a junction 
inserted.  Branches can be added, deleted, or split in Plan, Cross Section, or Long Section views. 
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Figure 78: Drawing Branches in Schematic Cross-Section 

 
During the initial schematic development in AutoCADTM, a node was inadvertently left out.  On 
the 1800 level (top level) the location for the regulator at the intersection of the level and the 
exhaust shaft was omitted. This can be rectified by either adding a branch for the regulator, or by 
inserting a node in the existing branch to split it to allow for the addition of the regulator. To do 
this the 3120 level must be displayed on the screen (see Figure 79). To view the 3120 level the 
user selects the level from the list provided by the drop down dialog box on the Toolbar, and 

then by pressing the  button. 
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Figure 79: Illustration of a Single Group (Level) and Group Filter  

 
In this case a node will be inserted in branch 48-32.  To insert the junction the user selects the 
“Create Junction” option from the Tools Menu or uses the Create Junction icon  located on the 
Toolbar.  The inserted node is displayed on Figure 80. 
 

 
Figure 80: Inserting a Junction 

 
The VnetPC Program will assign the junction the next free junction number and automatically 
place the newly created branch 50-32 on the 1800VENT group with all of the attributes 
belonging to that group. 
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5.5 Defining Branch Attributes (Resistances) 
 
Branch attributes can be defined or modified through either the Schematic View or the Branch 
Input View.  Because al subsurface airways do have some resistance each branch should have a 
resistance value assigned to it.  The exception is if the branch is being used solely for graphical 
representation.  To define the attributes or resistances for each branch, select the “Edit” option 
from the Tools Menu or use the  button located on the Toolbar.  Once the Edit tool has been 
selected, click on a branch, and the Branch Data dialog box (see Figure 81) will open.  All data 
that can be modified in this dialog box can also be modified in the Branch Input View. 
 

 
Figure 81:  Branch Data Dialog Box 

 
Each branch can be color coded to visually differentiate between airway types.  The Branch 
Code Menu allows the user to color code the schematic.  Each airway type can have an 
individual color assigned to it, or have the color modified by selecting “Define Colors” from the 
Preferences Menu and then selecting the “Branch Code” option.  
 
Every ventilation network, as with every mine, must have at least one intake and one exhaust 
airway connected to the surface (atmosphere).  The VnetPC Program requires that the intake and 
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exhaust portals and shaft surface connections be identified.  This system takes the place of the 
old method of creating zero resistance “atmospheric” branches connecting all surface junctions 
to some arbitrary atmospheric node.  It is important to ensure that the surface branch is identified 
correctly with the direction of airflow.  For example, a branch starting at a portal (node 1) and 
terminating at a airway junction (node 2) would be identified as an intake airway and is required 
to be written with the nodes ordered From 1 To 2.  
 
Each branch can also be allocated a symbol.  Symbols include bulkheads/stoppings, doors, 
brattices, and regulators.  In addition to the descriptive data, each branch can have a resistance 
assigned to it through this dialog box.  One of four methods can be used to assign or calculate the 
resistance for each branch by selecting from the drop-down list.  Additional cells will appear in 
the dialog box to allow the user to enter the necessary data to calculate branch resistance.  
 
When entering resistance data for k Factor (type 3) and Resistance per Length (R/L) (type 4), a 
tool (Auto Length) has been incorporated that will calculate the lengths of the branches 
according to their coordinate positions in the Schematic View.  This will only work for 
schematics that have been drawn to scale.  When entering resistance data for which a length is 
required in only a few branches, the Auto Length Selection box can be set to the Enabled mode. 
If an entire network is being developed, then the Auto Length can be enabled using the “Auto 
Length” from the Tools menu in the Schematic View.  A dialog box will appear as shown in 
Figure 82, the user will need to select a default for all new branches created or make changes to 
all existing branches.  The length of each branch will be updated automatically as junctions are 
moved or added to the schematic. 
 

 
Figure 82: Automatic Branch Length Calculation Dialog Box 

 

5.6 Inserting Fans and Fixed Quantities 
 
Once the attributes for each branch have been entered, the next step is to add fans or fixed 
quantities in the ventilation model.  These can be rapidly input to the model in the Schematic 
View; however, they may also be added in the Branch Input View, Fan Input View, or Fixed 
Quantities View.  To insert a fan, select “Fan or Fixed Q” from the Tools menu or use the Fan or 
Fixed Q icon  on the Toolbar, then click on the branch where the fan will be located.  Once the 
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branch is selected, the Add Fan or Fixed Quantity dialog box will be displayed as shown in 
Figure 83.  In this dialog box either the fan option or the fixed quantity option can be tagged. 
  

 
Figure 83: Fan or Fixed Quantity Dialog Box 

 
If the fan option is selected the Fan Data dialog box, Figure 84, will be displayed.  This dialog 
box allows the user to input the fan characteristics to the model.  Note that the nodes’ From/To 
order will specify the airflow direction for the fixed quantity or fan. 
 

 
Figure 84: Fan Data Dialog Box 

 
Another tool included in VnetPC allows the user to create a single fan and apply it to the model 
as a multiple, series or parallel installation.  This tool will automatically adjust the fan curves for 
multi-fan installations with identical fans.  If a fan is already defined in the fan database or if a 
fan characteristic curve is going to be added to the model, then the user selects the Edit Curve 
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button.  This will bring up the Fan Curve dialog box that contains the fan curve data series as 
illustrated in Figure 85. 
 

 
Figure 85: Fan Curve Dialog Box 

 
The individual properties of the fan are entered in the Fan Curve dialog box.  A maximum of 20 
points are allowed to be input for each curve.  It is generally a good idea to cluster the greatest 
number of points along the operating section of the fan curve.  The program will linearly 
interpolate between each of these points.  Once the fan curve is entered, select “OK”.  The 
buttons “Save” and “Import” refer to the Fan File Manager.  By selecting “Save” the fan curve 
will be saved to an existing fan database, and can be used in any model in the future by selecting 
“Import”.  This removes the task of continuously developing the same fan curve for different 
models.  Once the fan curve is entered in the dialog box, select the “OK” button.  The fan curve 
will then be incorporated into the model, it is not necessary to select “Save”. 
 

5.7 Adding a Contaminant 
 
In the VnetPC Program, a contaminant can be traced through the network.  This contaminant is 
added to the network by selecting the  button on the Toolbar or selecting “Contaminant” from 
the Tools menu.  A contaminant is inserted by selecting the desired branch with the contaminant 
curser, the Branch Contaminants dialog box, Figure 86, will be displayed on the screen.  In this 
dialog box the emission rate of the contaminant can be identified or the concentration of the 
contaminant in that branch can be inserted. 
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Figure 86:  Contaminant Dialog Box 

 
The downstream steady state concentrations and flow rates of the contaminant will be calculated 
for all affected branches. 
 

5.8 Program Execution 
 
Once the model is established the user should execute the simulation.  After successfully 
simulating the mine ventilation system the user can export the schematic back into AutoCADTM 
through a DXF file to provide an overlay of the projected ventilation values. 
  
During the program execution, any simulation errors detected by the program will be listed in a 
dialog box on the screen.  Information regarding these errors can be found in Section 4.4.1 and 
the Help program. 
 

6. Appendix: Tools and Tool Buttons 
 
The following list is a description of the buttons and tools available in the Schematic View. 
 

 Selection Pointer This button selects branches, and is the default mode.  The user can 
drag and drop existing junctions using this tool. It also has right 
button mouse features for editing objects. 

 Zoom In/Out These two buttons zoom in and out as referenced from the center 
of the schematic shown on the screen.  They are useful to apply 
when the Zoom Tool is not active, but the user still wishes to zoom 
the network. 

 Zoom All This tool zooms the extents of the schematic to fit the screen. 
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 Create Junction This tool creates/inserts a junction. 

 Create Branch This tool creates a new branch.  This tool features a drag and drop 
approach.  Select the initial point, and drag to the second point 
(keeping the left mouse button depressed). 

 Fan or Fixed Q This tool creates a fan or fixed quantity and inserts it in the 
selected branch. 

 Contaminant This branch adds a contaminant to the selected branch. 

 Create Label This tool allows the user to annotate or add text to the schematic. 

 Zoom This tool allows the user to “window” or zoom in on a specific 
area in the schematic.  The user may zoom to a window by 
dragging a rectangle on the screen.  The user may also zoom in and 
out using the left and right mouse buttons respectively (each click 
will zoom in or out one division). 

 Erase  This tool allows the user to rapidly erase selected objects. 

 Edit/Information This tool allows the user to edit the details of an object. 

 Plot Junction This tool will relocate any existing junction/node to another 
location selected by the user.   

 3-D Spin This tool allows the user to rotate the schematic.  The mouse is 
used to drag the schematic around a central axis to clarify the view 
of the network. 

 Cross-Section Change the view to the cross-section. 

 Long-Section Change the view to the long-section. 
 Plan View  View all groups (layers) in the plan view. 

 3D View View the schematic in three dimensions.  The schematic can then 
be actively dragged.  Branch and junction data can be edited in 
three dimensions. 

 Active Groups View only the active group (layer). 

 Edit Groups  Edit the layer attributes. 
 All Groups  View all groups (layers) in the current view. 
 Selected Groups View only the selected groups (layers) in the current view. 

 Undo/Redo Allows the users to undo and redo changes in the model.  The data 
will be restored in each branch by using the redo button.   
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